
Corticon
Installation Guide





Notices

Copyright agreement

© 2016 Progress Software Corporation and/or one of its subsidiaries or affiliates. All rights reserved.

These materials and all Progress® software products are copyrighted and all rights are reserved
by Progress Software Corporation.The information in these materials is subject to change without
notice, and Progress Software Corporation assumes no responsibility for any errors that may
appear therein. The references in these materials to specific platforms supported are subject to
change.

Business Making Progress, Corticon, DataDirect (and design), DataDirect Cloud, DataDirect
Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Deliver More
Than Expected, Icenium, Kendo UI, Making Software Work Together, NativeScript, OpenEdge,
Powered by Progress, Progress, Progress Software Business Making Progress, Progress Software
Developers Network, Rollbase, RulesCloud, RulesWorld, SequeLink, Sitefinity (and Design),
SpeedScript, Stylus Studio, TeamPulse, Telerik, Telerik (and Design), Test Studio, and WebSpeed
are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries
in the U.S. and/or other countries. AccelEvent, AppsAlive, AppServer, BravePoint, BusinessEdge,
DataDirect Spy, DataDirect SupportLink, Future Proof, High Performance Integration, OpenAccess,
ProDataSet, Progress Arcade, Progress Profiles, Progress Results, Progress RFID, Progress
Software, ProVision, PSE Pro, SectorAlliance, Sitefinity, SmartBrowser, SmartComponent,
SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame,
SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes
Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries
or affiliates in the U.S. and other countries. Java is a registered trademark of Oracle and/or its
affiliates. Any other marks contained herein may be trademarks of their respective owners.

Please refer to the Release Notes applicable to the particular Progress product release for any
third-party acknowledgements required to be provided in the documentation associated with the
Progress product.

3Progress Corticon: Installation Guide: Version 5.5.2



Progress Corticon: Installation Guide: Version 5.5.24

Notices



Table of Contents

Chapter 1: Overview of Corticon Installations.............................................7

Chapter 2: Preparing for a Corticon Installation.........................................9
Evaluation licensing...............................................................................................................................10

System requirements............................................................................................................................10

About Corticon upgrades......................................................................................................................11

Downloading Corticon installer packages.............................................................................................12

Applying a Service Pack update............................................................................................................13

Chapter 3: Installing Corticon Studio.........................................................15
Running the Corticon Studio installer wizards.......................................................................................16

Performing Silent Installations of Studio................................................................................................22

Installing Corticon Studio plugins into an existing Eclipse.....................................................................23

Optional post-install Studio tasks..........................................................................................................24

Upgrading projects coming forward from a prior release............................................................24

Changing the Studio's memory allocation..................................................................................27

Participating in the Studio Customer Experience Improvement Program...................................27

Chapter 4: Installing Corticon Servers and Web Console........................29
Running the Server and Web Console installer wizards.......................................................................30

Performing silent installations of Server components............................................................................36

Setting up and updating IIS for .NET Server.........................................................................................37

Creating custom context URLs on a web server...................................................................................37

Additional tasks to set up LDAP for Web Console.................................................................................38

Resetting the Web Console administrator password.............................................................................39

Chapter 5: Registering your Corticon license...........................................41
Updating your Corticon Studio license..................................................................................................41

Limits of your Corticon Studio license within Progress Developer Studio for OpenEdge...........42

Updating your Corticon Server license..................................................................................................42

Limits of the Server evaluation license.......................................................................................44

Chapter 6: Uninstalling Corticon Products................................................45

Appendix A: Access to Corticon knowledge resources...........................47

5Progress Corticon: Installation Guide: Version 5.5.2



Progress Corticon: Installation Guide: Version 5.5.26



1
Overview of Corticon Installations

This guide presents the preparation and procedures for accessing, downloading, and running
Corticon 5.5 installers, as well as dynamic access to the supported platforms and links to the setup
of third-party software in the Progress Corticon KnowledgeBase.

7Progress Corticon: Installation Guide: Version 5.5.2



Progress Corticon: Installation Guide: Version 5.5.28

Chapter 1: Overview of Corticon Installations



2
Preparing for a Corticon Installation

Before running installers
To avoid possible constraints on the installer, do the following:

• Confirm that you have Administrator permissions on the target machine - Administrator
rights allow the installer to copy all the Corticon files to their proper locations.You must have
Administrator rights and permissions to install this software. See your system administrator to
obtain these rights.

• Obtain system access -  Several Corticon features write files to the “home” directory structure. If
the target machine for the Corticon installation does not have read and write access to this
directory, you need to choose a directory location where Corticon will have both read and write
access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before
performing the installation, we recommend temporarily disabling any anti-virus and anti-spyware
software that may be running on the target machine, as such software might interfere with
correct installation.

For details, see the following topics:

• Evaluation licensing

• System requirements

• About Corticon upgrades

• Downloading Corticon installer packages

• Applying a Service Pack update
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Evaluation licensing
Progress Corticon products are licensed for evaluation immediately after installation.

Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development
of business rules projects and the use of the Enterprise Data Connector (EDC), as well as testing
of the projects in an embedded test server.You must obtain Studio development licenses from
your Progress representative.

Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule
modeling projects on supported platform configurations.You must obtain server deployment
licenses and server licenses that enable the Enterprise Data Connector (EDC) from your Progress
representative. See Limits of the Server evaluation license on page 44 to determine whether the
evaluation license will constrain your evaluation.

System requirements
Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio
Refer to the Progress Software web page Progress Corticon 5.5.2 - Supported Platforms Matrix
to review the currently supported Corticon Studio operating systems, and Eclipse versions.

The target system for a Corticon Studio installation requires:

• Supported Windows operating system

• 8 GB System RAM (minimum of 2 GB available RAM)

• 650 MB disk space

• When an existing Eclipse will be used, a supported Eclipse version

Corticon Server for Java
Refer to the Progress Software web page Progress Corticon 5.5.2 - Supported Platforms Matrix
to review the currently supported platforms and application servers. Also see the Corticon
KnowledgeBase entry  Corticon Server 5.X sample EAR/WAR installation for different Application
Servers  for detailed instructions on configuring Apache Tomcat, JBoss, WebSphere, WebLogic
on all supported platforms.

The target system for a Corticon Server for Java installation requires:

• Supported Windows operating system

• When deploying on other platforms, a supported operating system and application server

• 8 GB System RAM (minimum of 2 GB available RAM)

• 600 MB disk space
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Corticon Server for .NET
Refer to the Progress Software web page Progress Corticon 5.5.2 - Supported Platforms Matrix
for information on supported .NET Framework and IIS versions, and the Corticon Knowledgebase
articles Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7 for Corticon .NET Server
5.x and Steps to set up IIS 8.0 and 8.5 on Windows Server 2012 R1 and R2 for Corticon .NET
Server 5.x for detailed setup instructions.

The target system for a Corticon Server for .NET installation requires:

• Supported .NET Framework and Internet Information Service (IIS)

• 8 GB System RAM (minimum of 2 GB available RAM)

• 500 MB disk space

Note:  Corticon's Enterprise Data Connector (EDC) can be configured for Corticon Studio and
either Corticon Server. Refer to the Progress Software web page Progress Corticon 5.5.2 -
Supported Platforms Matrix to review the currently supported databases when using EDC with
Corticon Studio or Server.

Corticon Web Console
Refer to the Progress Software web page Progress Corticon 5.5.2 - Supported Platforms Matrix
for information on supported browser versions.

The target system for a Corticon Web Console installation requires:

• 4 GB System RAM (minimum of 2 GB available RAM)

• Java option for MaxPermSize set to at least 256m

• 600 MB disk space

Note: When all three Server components are installed on one machine, the required space for
the installation is about 1 GB.

About Corticon upgrades

Upgrading from an earlier release
Existing Corticon users advancing to this release will want to know whether their existing products
can co-exist with the newer version, as well as any strategies for perpetuating the assets created
in their current version.

Note:  Service Pack 2 rolls up the features of Service Pack 1.

If you have an existing installation of Corticon products on the target machine, do the following:

• For an upgrade of a 5.5.0 installation to 5.5.2 - If 5.5 or 5.5.1 is installed, download and install
the 5.5.2 Service Pack.

• For an upgrade of a 5.3 or 5.4 installation to 5.5.2 - If you are upgrading from 5.3 or 5.4, you
can install 5.5 as a separate installed software on the same machine, followed by its 5.5.2
Service Pack.You must manage any port overloads that might result from running both versions.
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• For an upgrade of a 5.2 or earlier version 5 installation to 5.5.2 - An installed version of
Corticon 5.2 or earlier installed on the target machine must be uninstalled, then the appropriate
Corticon 5.5 product installed, followed by its 5.5.2 Service Pack.

You might want to consult with Progress Corticon Support or your Progress representative to
discuss your migration strategies for existing assets before you take action.

• For an upgrade of a 4.3 or earlier installation to 5.5.2 - An installed version of Corticon 4.3
or earlier installed on the target machine must take an intermediate step of upgrading its assets
to at least 5.3, and then uninstalled.To accomplish this, you must download and install Corticon
Studio 5.3.0 or 5.4.0, and then perform the procedures in its Corticon Migration Guide. Once
completed, uninstall the 4.3 installation, and install 5.5 (followed by its 5.5.2 Service Pack)
where the upgrade utility can bring project assets up to date.You might want to consult with
Progress Corticon Support or your Progress representative to discuss your migration strategies
for existing assets before you take action.

Downloading Corticon installer packages
To download required Corticon installers:

1. Get credentials to access and download packages on the Progress Software Electronic Software
Download (ESD) site.

2. Connect to the ESD, and then navigate to the Corticon 5.5 and Corticon 5.5.2 pages.

3. Locate, download, and save the required installers to a temporary location accessible by the
target machine.

Downloading the Corticon Studio installer packages

Note:  Corticon Studio 5.5.2 installers are available in packages for 64-bit and 32-bit platforms.
Refer to your target machine's Control Panel > System page to choose the appropriate package.
While you could install the 32-bit version on a 64-bit machine, it is not recommended.

Corticon Studio 5.5.0 and its 5.5.2 Service Pack are packaged in executable installer applications:

• For supported 64-bit Windows machines:PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe
and PROGRESS_CORTICON_5.5.2_STUDIO_WIN_64.exe

• For supported 32-bit Windows machines:PROGRESS_CORTICON_5.5_STUDIO_WIN_32.exe
and PROGRESS_CORTICON_5.5.2_STUDIO_WIN_32.exe.

Downloading the Corticon Server and Web Console packages
Corticon Server and Web Console 5.5.0 products -- Java Server, .NET Server, and Web Console
and its 5.5.2 Service Pack -- are packaged in executable installer applications and ZIP archives:

• For supported 64-bit Windows machines:PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe
and PROGRESS_CORTICON_5.5.2_SERVER_WIN_64.exe.

• For installing Corticon Server or Web Console on other supported platforms or application
servers: PROGRESS_CORTICON_5.5.2_SERVER.zip.
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Applying a Service Pack update
When Progress releases a Service Pack for a version, the update is applied to an existing installation
that the Service Pack update wizard discovers on the target machine. To apply a Service Pack,
navigate to the Service Pack's download page to download the appropriate package, and then
unpack it on the target machine. For a new installation, perform the tasks for Installing Corticon
Studio on page 15, or Installing Corticon Servers and Web Console on page 29, and then run the
corresponding 5.5.x Service Pack update wizard. For an existing 5.5 installation, just run the
appropriate 5.5.x Service Pack to update the installation in place.

Note:  A higher Service Pack for a version rolls up the features of all preceding Service Packs.

13Progress Corticon: Installation Guide: Version 5.5.2

Applying a Service Pack update



Progress Corticon: Installation Guide: Version 5.5.214

Chapter 2: Preparing for a Corticon Installation



3
Installing Corticon Studio

There are several techniques for installing Corticon Studio:

• Running the Corticon Studio installer wizards on page 16, the typical use, which enables a
complete Corticon Studio Eclipse installation that can standalone, or be tailored into another
Eclipse IDE on the same machine, such as Progress Developer Studio for OpenEdge.

• Performing Silent Installations that generates a file from an installer wizard run to let you perform
silent Studio installations on other machines.

• Installing Corticon Studio plugins into an existing Eclipse on page 23 which enables scripted
installation of Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide
The installer wizard package includes:

• Corticon Studio resources

• Corticon Studio online documentation

• Eclipse Development Environment and Eclipse online documentation.

• Java Runtime Environment (JRE)

• Sample projects

• Tutorials

• API documentation for extending Corticon

• Corticon Server runtime for use in testing rules you create in Corticon Studio

15Progress Corticon: Installation Guide: Version 5.5.2



Installation options
A new Corticon Studio install lets you choose to install it standalone, or to add its resources to
either Progress Developer Studio for Open Edge 11.4/11.5 or another existing Eclipse 4.3
installation.

For details, see the following topics:

• Running the Corticon Studio installer wizards

• Performing Silent Installations of Studio

• Installing Corticon Studio plugins into an existing Eclipse

• Optional post-install Studio tasks

Running the Corticon Studio installer wizards
If you are installing the current release for the first time, you must install 5.5.0 and then apply the
5.5.2 Service Pack. If 5.5.0 is already installed, go ahead to Applying the 5.5.2 Service Pack on
page 20.

Installing Studio 5.5.0
To perform a new installation of Corticon Studio 5.5.0:

1. Double click on the appropriate installer file, PROGRESS_CORTICON_5.5_STUDIO_WIN_64.exe
or PROGRESS_CORTICON_5.5_STUDIO_WIN_32.exe, to launch the Corticon Studio installer.

The installer opens in the installer wizard.

2. The first installer panel opens with information about the installer.

3. Click Next to continue.
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The License Agreement panel opens.

This panel displays the Progress Software End User License Agreement (EULA). Use the scroll
bar at the right of the screen to read the agreement content.

4. When you understand and agree to the terms, choose I accept the terms in the license
agreement, and then click Next to continue.

The Choose Install Folder panel opens.

Note:  If you choose to install the 32-bit product on a 64-bit machine, the installation directory
defaults to C:\Program Files (x86)\Progress where (x86) distinguishes 32-bit
applications.The documentation will refer to C:\Program Files\Progress as the installation
path so be aware of this variation.
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5. Specify the installation location. The default location for the installation directory and the work
directory are as shown above. (For the work directory, the default subdirectory under Users
is the current username.) Either accept the default locations, or specify each preferred (and
different) location.

When you have the locations specified, click Next to continue.

6. The installer attempts to discover an existing Progress Developer Studio for OpenEdge on the
machine. If the Eclipse/OpenEdge version are compatible, and if the installer is the corresponding
bit width, the following panel opens:
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If this panel is displayed, choose whether to add the Corticon Studio plug-ins into that Progress
Developer Studio for OpenEdge location to get the benefit of a tailored installation, and then
click Next to continue.

7. If you had no Progress Developer Studio for OpenEdge installation, or passed on installing into
a discovered Progress Developer Studio for OpenEdge, the External eclipse configuration
panel opens:

• If you select Yes on this panel, the entry area for the External Eclipse location in which
you want to add Corticon Studio (in addition to a standard installation) is presented:
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Enter or browse to the location of the Eclipse target that is the same bit width as the installer
you are running.

• If you leave the selection as No, a normal installation will proceed.

When you have decided which path to take, click Next to continue.

8. The Pre-installation Summary panel opens.

Confirm that your installation location has adequate disk space for the Corticon Studio
components as well as at least 100 MB of workspace.

9. Click Install to continue.

An installation status window opens to display the state of the installation process. When the
process has finished, the Install Complete panel opens.

10. Click Done to quit and close the installer.

The installation of Corticon Studio 5.5.0 is complete.

Applying the 5.5.2 Service Pack
To apply the Corticon Studio 5.5.2 Service Pack to a 5.5.0 installation:

1. Double click on the appropriate installer file,
PROGRESS_CORTICON_5.5.2_STUDIO_WIN_64.exe or
PROGRESS_CORTICON_5.5.2_STUDIO_WIN_32.exe, to launch the Corticon Studio installer.

The installer opens in the installer wizard.

2. When the installer discovers the Studio 5.5.0 installation, the first installer panel opens with
information about the installer.
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3. Click Next to continue.

The License Agreement panel opens.

This panel displays the Progress Software End User License Agreement (EULA). Use the scroll
bar at the right of the screen to read the agreement content.

4. When you understand and agree to the terms, choose I accept the terms in the license
agreement, and then click Next to continue.

The Choose Install Folder panel opens.
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5. The Pre-installation Summary panel opens.

6. Click Install to continue.

An installation status window opens to display the state of the installation process. When the
process has finished, the Install Complete panel opens.

7. Click Done to quit and close the installer.

The installation of Corticon Studio 5.5.2 is complete.

Performing Silent Installations of Studio
An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected options, and then use the captured response file on other targets
to 'playback' the responses into the installer without any user interaction.

Note: The bit width of the installer package and the target machine's bit width must correspond.

To perform silent installations for Corticon Studio:

Note:  As 5.5.2 is a Service Pack release, you must have an existing 5.5.0 Studio installation on
every target machine.You can perform the following steps for the underlying 5.5.0 Studio installation
first, and then the Service Pack.

1. Run the Studio installer with your preferred locations and options to capture a response file,
using the syntax installer.exe -r file where installer is the preferred Studio installer,
and file is the response file you will reuse. For example,
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PROGRESS_CORTICON_5.5.2_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_552.responses

2. On other target machines, access the Studio 5.5 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_5.5.2_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_552.responses.

Installing Corticon Studio plugins into an existing
Eclipse

These instructions apply when you want to install Corticon functionality into an installed Eclipse
IDE.The technique uses a script to install plugins into an installed Eclipse 4.3.1 or 4.3.2 development
environment.

While product installer wizards require that you install 5.5.0 and then apply 5.5.2, this technique
does not require 5.5.0 to have been previously installed.

Note:  IMPORTANT: Do not use this procedure if you installed Corticon 5.5.0 with the installer
wizard and are now updating it to the current service pack. Instead, use the service pack installer
wizard to apply the update.

1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime
Environment (JRE). If you do not have one installed locally, download and install a 1.6 or higher
(1.7 preferred) version of the same bit-width as the existing Eclipse from the Oracle Java website
http://www.oracle.com/technetwork/java

Note:  For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is
using. In Eclipse, choose Window > Preferences, then select Java > Installed JREs.

2. Download and perform a standard installation of Corticon Studio into a clean directory on the
target machine. This installation will provide the script and the required files for the integration
into your target Eclipse location.

3. In a Command Prompt window at the Corticon Studio's [CORTICON_HOME]/Studio location,
check to see whether JAVA_HOME is set. If not, set JAVA_HOME to the JDK root. For example:
set JAVA_HOME=c:\jdk1.7u67_64

4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.

5. In the Command Prompt, run the integration script in the form:

integrateCorticon.bat –install eclipse_target

where eclipse_target is the root directory of the target Eclipse installation.

Eclipse installs its required plug-ins.
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6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK
to your PATH as the default Java to use. For example:

set PATH=%JAVA_HOME%\bin;%PATH%

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other
temporary files. For example:

set CORTICON_WORK_DIR=c:\corticon_work_dir

8. When the script successfully completes, restart the Eclipse session, and then verify the
installation by selecting the menu command Help > About Eclipse. Click Installation Details
to confirm that Progress Corticon Feature is installed.

9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is
being accessed correctly.

The integrateCorticon script enables other functions:

COMMAND SYNTAX AND OTHER OPTIONS
================================
Usage: integrateCorticon [OPTION] [TARGET_ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install
-install Install Corticon plugins in TARGET_ECLIPSE
-uninstall Uninstall Corticon plugins from TARGET_ECLIPSE
-update Update Corticon plugins in TARGET_ECLIPSE
-updateParams Update Corticon plugins parameters in TARGET_ECLIPSE
-help Display this message

Optional post-install Studio tasks
Once Studio is successfully installed, there are a few tasks you might want to perform.

Upgrading projects coming forward from a prior release
Every time you install a new release of Corticon Studio, many Corticon development assets
(Vocabularies, Rulesheets, Ruleflows, and Ruletests) might need to be upgraded for use in the
Corticon Studio. These could be projects you were working on or samples you imported from
another location. As you open each asset that needs to be upgraded, you are alerted as to the
required action, and encouraged to proceed to upgrade it. The asset upgrade process will force
the upgrade of dependent assets that also require a similar upgrade. This task can be tedious if
you have a lot of assets and a lot of projects.

The project upgrade utility lets you choose projects or folders of projects that will be upgraded all
in one pass. Typically, you would bring the projects into your workspace but you could choose to
point to folders that contain projects.

Performing this procedure just after upgrading your Corticon Studio will relieve you of having to
do this task as you work.

To upgrade a selected project:
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1. After your Studio upgrade has succeeded, choose the Upgrade Rule Assets command,

, on the dropdown menu that opens when you right-click on any
project name in the Projects Explorer view.The Upgrade Corticon Assets dialog box opens,
as shown:

In this example, the LifeInsurance project was selected so all the assets in that project are
selected for upgrade.

2. Click Finish to start upgrade processing.You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.

3. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade, as shown:
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You can choose to click Copy, and then paste the text into your preferred text editor.

4. Click OK to close the results window and the dialog box.

To upgrade one or more projects in one run:

1. Choose the Upgrade command, , on the dropdown menu that opens
when you click Project on the Corticon menubar (or on the dropdown menu of a selected project
in the Project Explorer tabs) The Upgrade Corticon Assets dialog box opens.

2. Click Browse to navigate to the branch of tree that could contain several Rule Projects, and
click OK. The projects and their assets are listed in the Upgrade Corticon Assets dialog box,
as in this example:
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Note:  For best performance, choose just several projects to upgrade in one run, and then
perform as many runs as needed.

3. Click Finish to start upgrade processing.You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.

4. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade.You can choose to click
Copy and then paste the text into your preferred text editor.

5. Click OK to close the results window and the dialog box.

Changing the Studio's memory allocation
When working on large projects, you will get better performance by increasing the available memory
for Corticon Studio. To change the Corticon Studio memory allocation, edit the command file
eclipse.ini located at [CORTICON_HOME]\Studio\eclipse, and then change (typically,
increase) the Xmx value (maximum memory setting). The default Xmx setting is 384 megabytes,
specified as Xmx384m.

Participating in the Studio Customer Experience
Improvement Program

Corticon uses Progress Telerik Analytics to gather data that will help Progress Software determine
product usage trends and improve product quality.
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When you first launch Corticon Studio and specify a workspace, the Customer Experience
Improvement Program dialog box opens. Read through the information in the dialog, and then
either check the option to sign up for the Customer Experience Improvement Program, or clear
the option to opt out. Clicking OK records your decision.

If you click Cancel (or click the close box), you are opted out.

If you choose to change workspace, you must select whether that workspace will participate.

Once Studio is running under the selected option, you can review or change the setting from the
Studio menu Window > Preferences > Progress Corticon. The option and its current value are
shown. If you change the option, click Apply, and then click OK.
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4
Installing Corticon Servers and Web Console

This section provides information about the installation procedures for the deployment and
administration components of Corticon as well as the Progress Application Server (PAS) -- a Web
application server based on Apache Tomcat -- that is used by the Java Server and the Web Console.

There are several techniques for installing Corticon Server components:

• Running the Server and Web Console installer wizards on page 30, the typical use, which
enables a complete Corticon Server for Java (and PAS), Corticon Server for .NET, and Corticon
Web Console (and PAS).

• Performing Silent Installations that generates a file from an installer wizard run to let you perform
silent installations of Server components on other machines.

• Using packages that facilitate setup of Corticon Server for Java and Java Server Console on
supported UNIX/Linux platforms and brands of Application Servers. Refer to the Progress
Software web page Progress Corticon 5.5.2 - Supported Platforms Matrix for the currently
supported platforms and app servers. Then see the Corticon KnowledgeBase entry  Corticon
Server 5.X sample EAR/WAR installation for different Application Servers  for detailed instructions
on configuring Apache Tomcat, JBoss, WebSphere, WebLogic on all supported platforms.

Note: The previous console implementation, Server Console, that was enabled in a Java Server
installation is still available. This legacy tool will be phased out in upcoming releases as the new
Web Console replaces the legacy tool's functionality.

For details, see the following topics:

• Running the Server and Web Console installer wizards

• Performing silent installations of Server components

• Setting up and updating IIS for .NET Server

29Progress Corticon: Installation Guide: Version 5.5.2

https://documentation.progress.com/output/ua/PAS/
https://documentation.progress.com/output/Corticon/5.5.2/redirectors/supported-platforms.html
http://knowledgebase.progress.com/articles/Article/000034367
http://knowledgebase.progress.com/articles/Article/000034367


• Creating custom context URLs on a web server

• Additional tasks to set up LDAP for Web Console

• Resetting the Web Console administrator password

Running the Server and Web Console installer wizards
If you are installing the current release for the first time, you must install 5.5.0 and then apply the
5.5.2 Service Pack. If 5.5.0 is already installed, go ahead to Applying the Server 5.5.2 Service
Pack on page 34.

Installing Server and Web Console 5.5.0
You can install Corticon Servers and the Web Console on a machine that does not already have
them installed. If you are upgrading from 5.3 or 5.4, you can install 5.5 as a separate installed
software version on the same machine.You must manage any port overloads that might result
from running both versions.

Note:  An installed version of Corticon Server 5.2 or earlier on the target machine must be
uninstalled, then Corticon Server 5.5 installed. Consult with Progress Corticon Support or your
Progress representative to consider your migration strategies for existing assets before you take
action.

Installation procedure
If you have already installed either of the 5.5 Servers or the Web Console, the installer will allow
you to install components not previously installed.

To create an installation of Corticon Servers (Java and .NET) and Web Console 5.5.0:

1. On the target machine, access the Corticon 5.5 installers you downloaded.

2. Double click on PROGRESS_CORTICON_5.5_SERVER_WIN_64.exe   to open the Progress
Corticon Server Setup Wizard.

The installer opens in the installer wizard. The first installer panel opens with information about
the installer.
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3. Click Next to continue.

The License Agreement panel opens.

4. After you have read, understood, and agreed to the terms of the End User License Agreement,
choose I accept the terms of the license agreement, and then click Next.

The Choose Install Folder panel opens.
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5. The default installation directories are shown. To specify preferred directories on each line,
either enter the explicit path, or click Choose to browse to each preferred directory.

Click Next.

The Choose Server Components panel opens.

6. Choose the one or more components you want to install at this time. Any components already
installed are chosen and greyed out.

Click Next.

If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.
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7. If any of the preferred ports conflict with existing applications, you can change them at this time
to an integer value from 1024 to 49151. Be aware that the documentation references these
ports as though the default values, as shown, were accepted. Consult with your system
administrator to identify alternate ports you might use, or to reset the ports on the conflicting
applications.

Enter your preferred port numbers, and then click Next.

The Pre-Installation Summary page opens.

8. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so
you can click Previous to go back to a panel to make changes, or click Cancel to quit this
installation procedure.

9. Click Install to continue.

The installation status window opens.

When done, the Install Complete panel opens.
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10. Choose Done to complete the Corticon Server / Web Console installation and close the installer.

The installation of Corticon Servers and Web Console 5.5.0 is complete.

Applying the Server 5.5.2 Service Pack
To apply the Corticon Server 5.5.2 Service Pack to a 5.5.0 installation:

1. On the target machine, access the Corticon 5.5.2 installers you downloaded.

2. Double click on PROGRESS_CORTICON_5.5.2_SERVER_WIN_64.exe   to open the Progress
Corticon Server Setup Wizard. When the installer discovers the Server 5.5.0 installation, the
first installer panel opens with information about the installer.
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3. Click Next to continue.

The License Agreement panel opens.

4. After you have read, understood, and agreed to the terms of the End User License Agreement,
choose I accept the terms of the license agreement, and then click Next.

The Pre-Installation Summary page opens.
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5. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so
you can click Previous to go back to a panel to make changes, or click Cancel to quit this
installation procedure.

6. Click Install to continue.

The installation status window opens.

When done, the Install Complete panel opens.

7. Choose Done to complete the update of the installed Corticon Server / Web Console components
and close the installer.

The installation of Corticon Server 5.5.2 is complete.

Performing silent installations of Server components
An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected components and options, and then use the captured response file
on other targets to 'playback' the responses into the installer without any user interaction.

To perform silent installations for Corticon Server Components:

Note:  As 5.5.2 is a Service Pack release, you must have an existing 5.5.0 Server installation with
corresponding components on every target machine.You can perform the following steps for the
underlying 5.5.0 Server installation first, and then the Service Pack.

1. Run the Server installer with your preferred locations and options to capture a response file,
using the syntax installer.exe -r file where installer is the preferred Server installer,
and file is the response file you will reuse. For example,
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PROGRESS_CORTICON_5.5.2_SERVER_WIN_64.exe -r
C:\CorticonServer64_552.responses

2. On other target machines, access the Server 5.5 installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the Server installer, and file is your response file. For example,
PROGRESS_CORTICON_5.5.2_SERVER_WIN_64.exe -i silent -f
C:\CorticonServer64_552.responses.

Setting up and updating IIS for .NET Server
The runtime server for Corticon .NET Server is Microsoft Internet Information Services (IIS), a
distinct setup into which you install the latest Corticon resources. This topic links to initial setup of
IIS, adjustments to its setup when upgrading, and the follow-up task to every upgrade or service
pack update that copies the latest resources to the IIS location.

To setup IIS to support Corticon .NET Server 5.5:

Corticon Knowledgebase articles Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7
for Corticon .NET Server 5.x and Steps to set up IIS 8.0 and 8.5 on Windows Server 2012 R1 and
R2 for Corticon .NET Server 5.x describe the complete configuration of .NET Framework and IIS
to support Corticon .NET Server 5.5.

Note:

To upgrade IIS for Corticon 5.5 - If you already have IIS setup for Corticon 5.4, you need to
adjust its configuration to support new features.

In Control Panel > Programs and Features, select Turn Windows feature on or off, and then
expand to Internet Information Services > World Wide Web Services. Select all the features
in the group Common HTTP Features.

To upgrade or update Corticon .NET Server into the IIS location:

1. Start Administrative Tool > IIS Manager. In the Actions panel, click Stop.

2. In [CORTICON_HOME_5.5]\Server .NET\IIS, launch install.bat.

3. Accept or adjust the target location, and then press Enter.The 5.5 resources and the deployment
descriptor files are copied. The corresponding assets are copied to the IIS path,
/Samples/Rules Projects.

4. In the IIS Manager, on the Actions panel, click Start.

Creating custom context URLs on a web server
Corticon web service deployment is preset to a singular web service identity, axis.You can choose
to replicate (or define and then relocate) another web deployment to run in the same host:port
context on Java servers and .NET servers.

To add another Java WAR file to a Java web server:
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This example clones the default WAR file, axis.war that was deployed on the embedded Progress
Application Server and running the axis.war web archive successfully. .

1. Stop the Java web server.

2. In [CORTICON_WORK_DIR]\pas\server\webapps, copy axis.war, and then paste it there
to make a copy.

3. Edit the name axis - Copy.war to your preferred .war name. Use alphanumeric characters
and underscores, and no spaces. For example Java_UAT.war for your user acceptance testing
instance.

4. Restart the Java web server.

The two Java server deployments run. Using the Web Console, you can manage the two distinct
server context URLs, for example, myServer:8850/axis and myServer:8850/Java_UAT.

To add another Corticon .NET web service to an IIS server:

This example clones the default .NET web service, axis that was installed from a Corticon .NET
Server installation to an IIS server configured for Corticon web services, and running the axis
application successfully.

1. In the IIS Manager, on the Actions panel, click Stop.

2. In the Server .NET's [CORTICON_HOME]\IIS folder, copy install.bat, and then paste it
there to make a copy.

3. install.bat.

4. Edit the name install - Copy.bat to your preferred .war name. Use alphanumeric
characters and underscores, and no spaces. For example install_anotherNET.

5. Edit that file to replace all instances of axis with anotherNET, and then save the edited file.

6. Run the script.

7. In the IIS Manager, perform the same tasks that were performed when axis was installed into
IIS. In brief:

a. Set Access Permissions for the application's directories,

b. Convert the new folder into an application.

c. Set the application to use the appropriate application pool.

See Setting up and updating IIS for .NET Server on page 37 for more information and links to
the various IIS setup articles in the Knowledgebase.

8. In the IIS Manager, on the Actions panel, click Start.

The two .NET server deployments run. Using the Web Console, you can manage the two distinct
server context URLs, for example, myServer:80/axis and myServer:80/anotherNET.

Additional tasks to set up LDAP for Web Console
You can set up Corticon Web Console to authenticate users using an LDAP server. To configure
LDAP authentication, edit the file CorticonServerConsoleConfig.groovy located in
<Corticon_Work_dir\etc>.

Uncomment all property lines in this file and enter values for the first four properties. Here is an
example:
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To map Web Console Admin and User roles to LDAP user groups, specify the user group names
in the ldap{}section at the bottom as shown in the image below. Use commas to define multiple
user groups for each role.

After setting these properties, save the file and restart Corticon Server. After Corticon Server starts,
LDAP users can log in to Web Console using their LDAP user credentials. Once an LDAP user
logs in, they are added to the USERS page in Web Console.

Note: Setting up LDAP authentication adds LDAP users to the Web Console user base.You can
still add other users in the USERS page and have them access Web Console using their Web
Console user credentials.

Resetting the Web Console administrator password
If the login password of the Web Console administrative user (admin) is lost, Corticon provides a
way to reset the password to the default (also admin).

To reset the administrator's password:

1. Stop the Corticon Server that is running the Web Console.

2. Select Start > All Programs > Progress > Corticon 5.5 > Corticon Command Prompt.

3. Enter set JAVA_OPTS=-DCORTICON_RESET_ADMIN_PASSWORD=true.

4. Enter pas\server\bin\startup.bat.

Corticon Server starts and resets the administrator's password.

After completing these steps, you can connect the Web Console and log in with the default
administrator credentials, user admin, password admin. It is good idea to immediately replace
the default password with your preferred administrator password.

This procedure applies to the application server that is installed by Corticon Server--the Progress
Application Server.You can perform similar steps for other supported application servers and
platforms. Consult your application server documentation for how to pass the JVM system property
CORTICON_RESET_ADMIN_PASSWORD to the server.
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Note:  Do not set this property in startup scripts as it will reset the password on each startup. This
should be only done only when the password needs to be reset. Subsequent launches of Corticon
Server and the Web Console should use the normal startup procedures.
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5
Registering your Corticon license

Progress Corticon customers must replace the evaluation license to enable the licensed features
and time limits.

When you obtain a license file, it applies to Studios as well as Servers.You must perform
configuration tasks to record it for each Corticon Studio, each Corticon Server, and each Deployment
Console. If you intend to use EDC on your Corticon Servers, your Corticon license must allow it.
Contact Progress Corticon technical support if you need to acquire a license.

For details, see the following topics:

• Updating your Corticon Studio license

• Updating your Corticon Server license

Updating your Corticon Studio license
When you are provided a license for Corticon Studio, you receive a JAR file. Save the file on the
target machine or at a location that is network-accessible to the installation. The default license
file for evaluation is embedded within the installation and cannot be replaced directly. In this
example, the license file, CcLicense.jar, that both Studio and Server will use is placed at
C:\licenses.

To update the evaluation Studio license, or add your non-evaluation Studio license:

1. With Studio running, select the menu command Window > Preferences.

2. Expand the Progress Corticon group.

3. In the License File entry area, enter or browse to the location of the license JAR:
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4. Click Apply, and then click OK.

5. Restart Corticon Studio.

Limits of your Corticon Studio license within Progress
Developer Studio for OpenEdge

To facilitate creation of a combined OpenEdge and Corticon Eclipse development environment,
Corticon Studio includes a WAR file to enable running Corticon Server from the Progress Developer
Studio. The embedded Studio license for Corticon Server has the following constraints:

• Corticon Server requests must originate on the machine where the server is running -- in other
words, all on localhost. Requests from any other machine or host are not allowed.

• Corticon Server allows only one reactor for execution of one instance of a specified Decision
Service. As a developer, you can locally deploy many Decision Services simultaneously, and
you can use administrative functions, such as service availabilities. When you are ready for
production system testing, you must obtain a Corticon Server deployment license, and then
locate it in Corticon Server installations.

Updating your Corticon Server license
When you obtain a Server license file as a customer, you need to locate it at the default locations
as well as the runtime locations.
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Updating the .NET server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server .NET\samples\lib\

• [CORTICON_HOME]\Server .NET\webservice\lib\

• The IIS location, typically: C:\inetpub\wwwroot\axis\lib\

Updating the Java server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server\lib\

Note: When you download .ear and .war files for deployment onto other supported platforms
and application servers, they contain the evaluation CcLicense.jar. Once you are a Corticon
customer, you are provided a permanent version of this file. Inserting the CcLicense.jar file
into the .ear or .war will replace the evaluation file to redefine the license limitations.

Note:  If you intend to use the Corticon High Performance Batch Processor, you will need to also
update its license file, located at [CORTICON_HOME]\Samples\HPBP\src\test\resources\
.

Once you have run Corticon Server, you can update its license locations with your license.

To configure Corticon Server to access your license file:

1. Stop Corticon Server.

2. Copy your license JAR by its default name, CcLicense.jar.

3. Navigate to the installation's [CORTICON_HOME]\Server\lib directory to paste the file and
overwrite the existing file in that location.

4. Navigate to the installation's
[CORTICON_WORK_DIR]\Server\pas\server\webapps\axis\WEB-INF\lib directory
to paste the file and overwrite the existing file in that location.

When you restart Corticon Server, your license file will be referenced.

When you launch the Corticon Deployment Console, your license with its registration information
is registered for the Corticon Deployment Console. If your license enables EDC, the Database
Access  fields and functions are enabled.
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Note:

You can choose to locate the license by another JAR name at a preferred location, and then
expressly identify it to the server.

To custom configure Corticon Java Server's license location:

1. Navigate in the file system to the installation's [CORTICON_HOME]\Server\bin subdirectory.

2. Double-click on testServerAxis.bat, then do the following:

a. Type 416 and then press Enter.

b. Enter (or copy/paste) the complete path to the location of the license JAR file, as in this
example, C:\licenses\myCorticon55_EDC_CcLicense.jar. The command echoes
back Transaction completed.

c. To confirm the setting, type 415, and then press Enter. The path is echoed back.

3. For the in-process instance, double-click on testServer.bat to perform the same 416 and
415 tasks as in Step 2 above

Limits of the Server evaluation license
The license included in the default Corticon Server installation has pre-set limits on certain Corticon
Server and Decision Service parameters. These limits are:

• Number of Decision Services – Up to 20 Decision Services may be deployed at any given
time. This means the sum total of all Decision Services loaded via .cdd files, Web Console,
or APIs cannot exceed 20.

• Number of Rules – All rules in all deployed Ruleflows (that is, all deployed Decision Services)
must not exceed 500. A rule generally consists of a single Condition/Action Column or a single
Action row in Column 0. Filter expressions do not count because they only modify other rules.

• Enterprise Data Connector (EDC) - EDC is disabled in a Server evaluation license and must
be explicitly licensed in a deployment Server license. Note that the Corticon Studio enables
EDC in both evaluation and deployment versions.

The Corticon Server log can capture errors and exceptions caused by expired or "under-strength"
licenses. These log messages are detailed in the Using Corticon Server logs section of the
Integration and Deployment Guide.

If you are Progress Corticon customer, you should have access to an unlimited license that will lift
these restrictions. If you are an evaluator, and discover that these limitations are preventing or
inhibiting your evaluation, contact your Progress Software representative to get a license with
expanded capabilities.
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6
Uninstalling Corticon Products

Uninstalling Corticon Studio
To remove a version of Corticon Studio, use this procedure.

Note:  Uninstall removes a complete major.minor version.You cannot uninstall just a Service Pack.

Note:  Uninstalling Corticon Studio 5.5 will not impact any other installed major.minor version of
Corticon Studio.

To uninstall Corticon Studio:

1. Close Studio.

2. Choose the Start menu Control Panel function Programs and Features, and then double-click
on Progress Corticon Studio 5.5 to launch its uninstaller.

Note: You could initiate the same task directly by navigating to
[CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.5, and then running
Uninstall Progress Corticon Studio 5.5.exe.

The installed files in the Studio's [CORTICON_HOME] are removed. Files you created (including
the complete workspace) are NOT removed or replaced during this process.

If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.
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Uninstalling Corticon Server
To remove a version of the server components to prepare for a new installation (or if you want to
fully remove them), use this procedure.

Note:  Uninstall removes a complete major.minor version.You cannot uninstall just a Service Pack.

Note:  Starting in 5.5, the Corticon Server components -- Corticon Server for Java, Corticon Server
for .NET, and the Corticon Web Console -- use common installation directories. As such, you
cannot choose to uninstall just selected components. Uninstallation will remove all installed server
components.

To uninstall Corticon Server:

1. Stop Corticon Servers.

2. Backup any files you want to retain.

3. Choose the Start menu Control Panel function Programs and Features, and then double-click
on Progress Corticon Server 5.5 to launch its uninstaller.

Note: You could initiate the same task directly by navigating to
[CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.5, and then running
Uninstall Progress Corticon Studio 5.5.exe.

4. Navigate to [CORTICON_HOME]\Uninstall_Progress Corticon Server 5.5.

5. Run Uninstall Progress Corticon Server 5.5.exe.

The installed files in the Server's [CORTICON_HOME] are removed. Note that files you created
are NOT removed or replaced during this process. No server files in the [CORTICON_WORK_DIR]
are removed.

If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.

Progress Corticon: Installation Guide: Version 5.5.246

Chapter 6: Uninstalling Corticon Products



A
Access to Corticon knowledge resources

Complete online documentation for the current release

Corticon online tutorials:

• Tutorial: Basic Rule Modeling in Corticon Studio

• Tutorial: Advanced Rule Modeling in Corticon Studio

• Modeling Progress Corticon Rules to Access a Database using EDC

• Connecting a Progress Corticon Decision Service to a Database using EDC

Corticon guides (PDF):

• What's New in Corticon

• Corticon Installation Guide

• Corticon Studio: Rule Modeling Guide

• Corticon Studio: Quick Reference Guide

• Corticon Studio: Rule Language Guide

• Corticon Studio: Extensions Guide

• Corticon Server: Integration and Deployment Guide

• Corticon Server: Web Console Guide

• Corticon Server: Deploying Web Services with Java

• Corticon Server: Deploying Web Services with .NET
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Corticon JavaDoc API reference (HTML):

• Corticon Foundation API

• Corticon Model API

• Corticon Server API

See also:

• Introducing the Progress® Application Server

• Corticon documentation for this release on the Progress download site: What's New Guide
(PDF), Installation Guide (PDF), PDF download package, and the online Eclipse help installed
with Corticon Studio.
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